Presentations: Creating conference posters using PowerPoint
How to Use This Book

This handbook accompanies the taught sessions for the course. Each section contains a brief overview of a topic for your reference and then one or more exercises.

The Exercises

Exercises are arranged as follows:

- A title and brief overview of the tasks to be carried out
- A numbered set of tasks, together with a brief description of each
- A numbered set of detailed steps that will achieve each task

Some exercises, particularly those within the same section, assume that you have completed earlier exercises. Your lecturer will direct you to the location of files that are needed for the exercises. If you have any problems with the text or the exercises, please ask the lecturer or one of the demonstrators for help.

This book includes plenty of exercise activities – more than can usually be completed during the hands-on sessions of the course. You should select some to try during the course, while the teacher and demonstrator(s) are around to guide you. Later, you may attend follow-up sessions at IT Services called Computer8, where you can continue to work on the exercises, with some support from IT teachers. Other exercises are for you to try on your own, as a reminder or an extension of the work done during the course.

Writing Conventions

A number of conventions are used to help you to be clear about what you need to do in each step of a task.

- In general, the word press indicates you need to press a key on the keyboard. Click, choose or select refer to using the mouse and clicking on items on the screen (unless you have your own favourite way of operating screen features).
- Names of keys on the keyboard, for example the Enter (or Return) key, are shown like this ENTER.
- Multiple key names linked by a + (for example, CTRL+Z) indicate that the first key should be held down while the remaining keys are pressed; all keys can then be released together.
- Words and commands typed in by the user are shown like this.
- Labels and titles on the screen are shown like this.
- A button to be clicked will look like this.
- The names of software packages are identified like this, and the names of files to be used like this.
Software Used

Windows XP
PowerPoint 2010 (PC)

Files Used

Monumentvalley.jpg
Geological_time_spiral.png
ox_brand_cmyk_rev.eps
Lorem Ipsum.doc
Lorem Ipsum.txt

Revision Information

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Author</th>
<th>Changes made</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.0</td>
<td>October 2009</td>
<td>Dave Baker</td>
<td>Complete rewrite</td>
</tr>
<tr>
<td>4.1</td>
<td>March 2010</td>
<td>Dave Baker</td>
<td>Changes to layout</td>
</tr>
<tr>
<td>5.0</td>
<td>August 2011</td>
<td>Dave Baker</td>
<td>Updated to PPT 2010</td>
</tr>
<tr>
<td>5.1</td>
<td>September 2012</td>
<td>Dave Baker</td>
<td>Updates to text and IT Services branding</td>
</tr>
<tr>
<td>5.1a</td>
<td>February 2013</td>
<td>Dave Baker</td>
<td>Enhanced Poster Design section. Update to evaluation form.</td>
</tr>
<tr>
<td>5.1b</td>
<td>September 2013</td>
<td>Dave Baker</td>
<td>Minor cosmetic changes</td>
</tr>
<tr>
<td>5.2</td>
<td>August 2014</td>
<td>Dave Baker</td>
<td>Add trim border text</td>
</tr>
<tr>
<td>5.2a</td>
<td>January 2015</td>
<td>Dave Baker</td>
<td>Added Interactive Posters appendix</td>
</tr>
</tbody>
</table>

Acknowledgements

With thanks to Anna Pavelin for proofreading and providing feedback on the course structure.

Copyright

Dave Baker makes this document and the accompanying PowerPoint presentation available for reuse under a Creative Commons licence (Attribution-NonCommercial-ShareAlike CC BY-NC-SA)

Screen shots in this document are copyright of Microsoft.

The image of Monument Valley is from


The image of the geological time spiral is from:


The Oxford University logo is copyright of Oxford University and may only be used by Oxford University members in accordance with the University’s branding guidelines.
# Contents

1 Introduction ................................................................. 1
   1.1. What You Should Already Know .............................................. 1
   1.2. What You Will Learn .............................................................. 1
   1.3. Using Office 2010 ................................................................. 1
   1.4. What is PowerPoint (a reminder)? ........................................... 3
   1.5. Where can I get a copy of PowerPoint? ................................. 3

2 Poster Design ............................................................. 4
   2.1. The focus of your poster ....................................................... 4
   2.2. What you must have ............................................................ 5
   2.3. Size and orientation ............................................................ 6
   2.4. Trimming to size ................................................................. 7
   2.5. Structure ........................................................................... 7
   2.6. Using a grid ........................................................................ 7
   2.7. The importance of empty space ........................................... 8
   2.8. Colour ................................................................................ 8
      2.8.1. Background colour .......................................................... 9
      2.8.2. Text colour ....................................................................... 9
      2.8.3. Diagram colour ............................................................ 9
      2.8.4. Image colour .................................................................... 9
   2.9. First step ........................................................................... 9

3 Tools ............................................................................... 10
   3.1. Poster design ................................................................. 10
   3.2. Image editing ................................................................. 12
   3.3. Data analysis ................................................................. 12

4 Using graphics ........................................................... 13
   4.1. Images ........................................................................... 13
      4.1.1. Vector images ............................................................... 13
      4.1.2. Bitmap images ............................................................... 13
      4.1.3. Sourcing your images .................................................... 14
      4.1.4. Copyright .................................................................... 15
      4.1.5. Placing images ............................................................. 15
   4.2. Diagrams ........................................................................ 16
      4.2.1. Creating diagrams ....................................................... 16
      4.2.2. Importing diagrams ..................................................... 16
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3. Equations</td>
<td>16</td>
</tr>
<tr>
<td>4.4. Charts and graphs</td>
<td>17</td>
</tr>
<tr>
<td>4.4.1. Chart design</td>
<td>17</td>
</tr>
<tr>
<td>4.5. Quick Response (QR) codes</td>
<td>17</td>
</tr>
<tr>
<td>5 Using Text</td>
<td>19</td>
</tr>
<tr>
<td>5.1. Font sizes</td>
<td>19</td>
</tr>
<tr>
<td>5.2. Fonts</td>
<td>19</td>
</tr>
<tr>
<td>5.3. How much text?</td>
<td>20</td>
</tr>
<tr>
<td>5.4. Managing text boxes</td>
<td>20</td>
</tr>
<tr>
<td>5.4.1. Using text from elsewhere</td>
<td>20</td>
</tr>
<tr>
<td>5.5. Using Tables</td>
<td>20</td>
</tr>
<tr>
<td>6 Using Layers</td>
<td>22</td>
</tr>
<tr>
<td>6.1. Layering text and graphics</td>
<td>22</td>
</tr>
<tr>
<td>7 Proofing and printing</td>
<td>23</td>
</tr>
<tr>
<td>7.1. Proofreading</td>
<td>23</td>
</tr>
<tr>
<td>7.2. Evaluating your poster</td>
<td>23</td>
</tr>
<tr>
<td>7.3. Printing</td>
<td>25</td>
</tr>
<tr>
<td>7.3.1. Versions, fonts and images</td>
<td>25</td>
</tr>
<tr>
<td>7.3.2. Producing a PDF version</td>
<td>25</td>
</tr>
<tr>
<td>7.3.3. Colours</td>
<td>25</td>
</tr>
<tr>
<td>8 Delivering the poster</td>
<td>26</td>
</tr>
<tr>
<td>8.1. Transporting and fixing</td>
<td>26</td>
</tr>
<tr>
<td>8.2. The poster session</td>
<td>26</td>
</tr>
<tr>
<td>8.3. Poster handout</td>
<td>26</td>
</tr>
<tr>
<td>9 The workshop</td>
<td>27</td>
</tr>
<tr>
<td>9.1. Class Resources</td>
<td>31</td>
</tr>
<tr>
<td>10 What Next?</td>
<td>65</td>
</tr>
<tr>
<td>10.1. Other PowerPoint sessions</td>
<td>65</td>
</tr>
<tr>
<td>10.2. Computer8</td>
<td>65</td>
</tr>
<tr>
<td>10.3. IT Services Help Centre</td>
<td>65</td>
</tr>
<tr>
<td>10.4. Downloadable course materials (WebLearn)</td>
<td>65</td>
</tr>
<tr>
<td>10.5. Further reading</td>
<td>65</td>
</tr>
<tr>
<td>11 Appendix – Interactive posters</td>
<td>66</td>
</tr>
<tr>
<td>11.1. Interactive poster size and orientation</td>
<td>66</td>
</tr>
<tr>
<td>11.2. Inserting video and audio</td>
<td>67</td>
</tr>
</tbody>
</table>
11.3. Adding interactive elements............................................................... 67
11.3.1. Action buttons ................................................................................ 67
11.3.2. Flash ................................................................................................ 67
List of ‘How To…’ guide sheets

Create a blank slide (poster!) ................................................................. 33
Change the page orientation and size .................................................. 34
Add a trim border to the poster ............................................................ 35
Setup a grid and guidelines ................................................................. 36
Change the poster background colour ................................................ 37
Add a background image ................................................................... 38
Add design elements to the background .......................................... 39
Insert placeholders ........................................................................... 40
Convert a shape to a text box .............................................................. 41
Add text ............................................................................................... 42
Format text .......................................................................................... 43
Insert existing text ............................................................................ 44
Check the resolution of an image ...................................................... 45
Insert an image .................................................................................. 46
Insert an image into a shape .............................................................. 47
Resize, crop and position an image .................................................. 48
Make adjustments to a picture’s colour .............................................. 49
Use a PowerPoint diagram ............................................................... 50
Create a diagram .............................................................................. 51
Create a chart .................................................................................... 52
Adjust a chart’s design ..................................................................... 53
Insert an existing chart ................................................................. 54
Create an equation ........................................................................... 55
Create a table ..................................................................................... 56
Modify a table .................................................................................... 57
Insert an existing table ................................................................. 58
Print a poster proof ........................................................................... 59
Create a PDF for printing ................................................................. 60
Inserting a video clip ....................................................................... 61
Inserting an audio clip ..................................................................... 62
Trimming a media clip .............................................................. 63
Adding an action button ........................................................... 64
1 Introduction

Welcome to the course PowerPoint: Academic Conference Posters.

This booklet accompanies the course delivered by University of Oxford IT Services, IT Learning Programme. Although the exercises are clearly explained so that you can work through them yourselves, you will find that it will help if you also attend the taught session where you can get advice from the teachers, demonstrators and even each other!

If at any time you are not clear about any aspect of the course, please make sure you ask your teacher or demonstrator for some help. If you are away from the class, you can get help by email from your teacher or from help@it.ox.ac.uk

1.1. What You Should Already Know

This session assumes that you are familiar with the basic features of PowerPoint. For example, you should be able to:

- Insert slides
- Add and edit text
- Apply simple formatting such as changing font size and colour

We will also assume that you are familiar with opening files from particular folders and saving them, perhaps with a different name, back to the same or a different folder.

The computer network in the teaching rooms may differ slightly to that which you are used to in your College or Department; if you are confused by the differences, ask for help from the teacher or demonstrators.

By the way, we did say that you can ask for help from the teachers or demonstrators 😊!

1.2. What You Will Learn

This session covers the use of PowerPoint in producing scientific posters. It concentrates on the techniques of the tool, rather than the design of the poster. Poster design is covered in an accompanying session.

We will cover the following topics:

- Setting up the page
- Adding and manipulating text
- Adding and manipulating graphics
- Adding and manipulating charts and tables
- Previewing and printing your poster

1.3. Using Office 2010

If you have previously used another version of Office, you may find Office 2010 looks rather unfamiliar. “Office 2010: What’s New” is a self-study guide covering the Ribbon, Quick Access Toolbar and so on. This can be downloaded from the ITLP Portfolio at portfolio.it.ox.ac.uk.

For anyone who prefers not to use the mouse to control software, or who finds a keyboard method more convenient, it is possible to control Office 2010 applications without using a mouse. Pressing ALT once displays a white box with...
a letter or character next to each visible item on the Ribbon and title bar (shown in Figure 1).

Figure 1 Keystrokes to Control Ribbon Tabs and Title Bar (Press ALT to Show These)

After you type one of the letters/characters shown, the relevant Ribbon tab or detail appears, with further letters/characters for operating the buttons and controls (shown in Figure 2).

Figure 2 Further Keystrokes to Control Buttons

The elements of a dialog can be controlled, as usual with Windows applications, by using TAB to navigate between items or typing the underlined character shown beside an item.
1.4. What is PowerPoint (a reminder)?

*PowerPoint 2010* is part of the *Microsoft Office 2010* package. It enables you to create professional, attractive slides for presentations. These can include not only text, but images, animations, movies and sound.

Each slide can have notes associated with it which can be printed out to help you through the presentation. You can also produce hand-outs based on your presentation to supply to your audience.

As well as a presentation tool, *PowerPoint* can be used to produce simple drawings, sketches and posters.

1.5. Where can I get a copy of PowerPoint?

If you have a copy of *Microsoft Office 2010*, then you already have a copy of *PowerPoint 2010*. If you are unable to find it on your computer, it may not have been installed and you should talk to your IT support contact (or the IT Services Help desk).

If you are a member of staff, you can obtain a copy of *Microsoft Office 2010* from the IT Services on-line shop.

If you are a student, Microsoft often run special offers where students can get the Microsoft Office suite at greatly reduced cost. Most on-line software resellers sell the student versions, although you may need to prove your student status.
2 Poster Design

What can be difficult about creating a poster? After all, you just take some text – maybe an extended abstract from one of your recent papers – throw in an image, a graph of some data and a diagram or two, switch on the blender and stand back.

At least, that’s what we might guess has happened when we look at some posters!

Creating a good poster is just like creating a good anything; it takes time and careful planning and a little skill.

If you have the budget, then hire a graphic designer and you will end up with an attractive poster. Most of us don’t have that luxury, and even if we do, it doesn’t absolve us from coming up with the text and graphical content for the designer to work from. So, below and in the rest of this booklet you will find some guidance on poster design and implementation.

2.1. The focus of your poster

One of the most difficult decisions when designing your poster will be what to leave out. People who visit your poster will have a limited amount of time they are willing to invest in it – there will be many more posters they want to look at. You need to think carefully what it is you want that you want to say, and how much they will be able to absorb in those few minutes of attention.

There are four common reasons why you might create a poster:

**Outreach and engagement** – communicating your research and other activities with people outside your field

**An overview** – Past, present and/or future

**Results** – Your research results, either interim or final.

**Event awareness** – advertising a conference or workshop

However, there are a number of different strategies employed by marketing agencies that you could consider for your poster. Here are some (from an article by Tiffany Farrant Gonzalez and Jarred Romley, in .net magazine January 2013):

<table>
<thead>
<tr>
<th>Strategy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>History</strong></td>
<td>How xyz got to be here</td>
</tr>
<tr>
<td><strong>Summary</strong></td>
<td>an overview of xyz.</td>
</tr>
<tr>
<td><strong>Results</strong></td>
<td>“I’ve finished!”; here is xyz.</td>
</tr>
<tr>
<td><strong>Enlightenment</strong></td>
<td>You might not know that xyz exists; here’s how it does.</td>
</tr>
<tr>
<td><strong>Opportunity</strong></td>
<td>You might think xyz isn’t possible; here is why it is.</td>
</tr>
<tr>
<td><strong>Fear</strong></td>
<td>You might think that xyz is OK; here is why it isn’t.</td>
</tr>
<tr>
<td><strong>Soothing</strong></td>
<td>You might think that xyz is not OK; here is why it is.</td>
</tr>
<tr>
<td><strong>Humour</strong></td>
<td>You might think that penguins would make poor researchers, and you would be absolutely right!</td>
</tr>
</tbody>
</table>
2.2. What you must have

The majority of posters follow a tried and tested standard format:

If you want your poster to stand out, and surely you do, you might decide to break out of the mould and create something different:
Whatever your design is, there are four elements that your poster MUST have:

**Title**
Clearly the title should represent the content of the poster, but at the same time it should attract people's attention. If you decide to use a slightly cryptic title, it can help to have a more informative sub-title.

**Author**
It is surprising how many people forget to put their names on the poster!

**Affiliation**
You should always make it clear who/where you work. If the project is sponsored, then you should also include the sponsor's name and/or logo.

Always use the correct Oxford logo. Details (and downloadable images) are available from the University web site at: www.ox.ac.uk/branding_toolkit

**Contact details**
Make sure that you include your contact details. Many authors include their email address. If you do so, use your Oxford address in preference to your hotmail/gmail address. It is also becoming common to include a small 'passport' photo next to your name so that people can recognise you if they want to talk to you about your poster.

### 2.3. Size and orientation

Conference organisers will tell you how much space you will have available, or the maximum size of the poster. They may also request that posters are in a
particular orientation (portrait or landscape). Very occasionally they may specify other layout requirements, such as the font size for titles.

Make sure that you comply with their instructions! If unsure, ask for clarification.

Standard poster sizes are:

<table>
<thead>
<tr>
<th>Paper Size</th>
<th>Portrait (w x h)</th>
<th>Landscape (w x h)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A0</td>
<td>84.1 x 118.9 cm</td>
<td>118.9 x 84.1 cm</td>
</tr>
<tr>
<td>A1</td>
<td>59.4 x 84.1 cm</td>
<td>84.1 x 59.4 cm</td>
</tr>
<tr>
<td>A2</td>
<td>42.0 x 59.4 cm</td>
<td>59.4 x 42.0 cm</td>
</tr>
</tbody>
</table>

2.4. Trimming to size

Your poster will be printed on a large roll of paper and then trimmed to the correct size. To make sure it gets trimmed correctly, it is helpful to print a thin ‘trim line’ at the very edge of the poster. This can be particularly important for posters on a white background, where there is a risk that your carefully considered (blank) border gets trimmed off.

2.5. Structure

Your poster will be one of many, and visitors will not have long to spend looking at yours. Make sure that the structure of the poster guides them through the content in a logical order.

It would be unusual for a poster not to adhere to the Start → Middle → End convention. How you satisfy this depends on your content; in many research contexts, this might be Introduction → Method → Results → Conclusion.

The path a visitor should follow through a poster is often implied by one of:

- **Layout**
  For example, a columned layout would normally be read starting with the left-hand column.

- **Headings**
  For example, the headings Introduction, Method, Results, Conclusion would immediately suggest an order in which sections are to be read.

- **Numbering**
  Self-evident but, of course, you could use letters instead.

- **Graphic device**
  For example, in the poster layout we saw in Figure 4 above, the arrangement of the circles suggested we read the content from top left to bottom right, but with the connecting lines showing that certain circles should be read as a collection.

Occasionally, you may decide to have some central diagram or image and then arrange your content around it, on the assumption that visitors will read those items that are interesting to them. If there is a danger that they might then miss important information, direct their attention to it by colour, size, or placement. Or indeed, using numbering to give a structure to the items.

2.6. Using a grid

There is one important design rule for those of us who are not graphic designers: “Everything should line up with something”
An easy way to help with this is to set up a grid, dividing the poster up into a series of blocks or cells. The boundaries of these blocks can then be used to help with alignment.

Having set up a grid, you can decide to 'break out' from it, but this should be a conscious decision rather than an accident. Below is a gridded layout, with an example of a poster rigorously conforming to the grid, and another example of content that 'breaks' the grid, but still lines up with 'something'.

![Grid layout](image)

**Figure 5 Two posters based on the same grid**

Even without a grid, you should try and make the placement of items on the poster look purposeful rather than random, accidental or clumsy.

### 2.7. The importance of empty space

It is very tempting to fill every part of your poster with information – text, images, diagrams, logos. However it is important to give each item on the poster enough space around it to make it easy for the visitor to see that it is a separate item, distinct from other content.

You will find that most successful posters have a significant amount of empty space; a good rule of thumb is:

- 20 - 25% text
- 40 - 45% graphics
- 30 - 40% empty space

Be very careful about placing content right to the edge of the poster; it can make the poster look 'cramped', but also there is a risk that the printer may not print to the edge, or that content gets trimmed off.

### 2.8. Colour

Colour is very subjective in design. Good advice is, as ever, if you are not a graphics designer, or you don’t have confidence in your use of colours, keep it simple; one or two predominant colours work well, with extra colour being provided by your images and diagrams.

Printed colour will often be different to the colour you see on the screen when designing your poster, with colours often appearing much more vibrant on-screen than on the poster. It is difficult to avoid this without properly calibrating your
monitor to the ink-paper-printer combination used, and calibration is not straightforward.

If a particular colour is important to you, then you might want to co-ordinate with the people printing your poster and perhaps carry out some test prints.

2.8.1. Background colour

The majority of posters use a white background. This gives good contrast with most sensible text colours, and works well when diagrams also have a white background.

Dark backgrounds can also work well, but diagrams may then need extra work to integrate them with the poster design.

If you choose a gradient background, be sure that the colour gradient is not too exaggerated otherwise you will have trouble choosing a suitable font colour that will stand out on all parts of the poster.

If you decide to use an image background take care that it doesn’t detract unnecessarily from the content.

2.8.2. Text colour

The text colour should always provide a good contrast with any background.

If you use more than one text colour, do so for a reason – perhaps to highlight a particular word or section of text – and be consistent in the way that you use the colour variations.

Artistic effects and fills to text are usually best avoided – they can make the text difficult to read.

2.8.3. Diagram colour

If you have chosen a particular colour theme for the rest of your poster, then you should consider carrying this through to your diagrams. For example, a bar chart might use hues of the main poster colour for the different bars.

Blocks of colour work much better than patterns when filling bars and segments.

You will need to make lines on the diagrams thicker than normal so that they can be seen from a distance.

2.8.4. Image colour

On an otherwise plain, one or two colour poster, you can add extra colour interest through the use of appropriate images. Particular issues that are important to consider about images are covered later.

If you are using artwork such as the University or sponsor’s logo, you should keep the original colours. In particular, there are strict guidelines on the colours that can be used for the Oxford University logo: www.ox.ac.uk/branding_toolkit/the_brand_colours/index.html

2.9. First step

Bearing in mind the advice given above, and before starting to construct your poster in your chosen design tool, you should first spend some time with pencil and paper and produce one or more sketches of possible layouts.

This will save time in the long run, and avoid the tool directing you along a particular path.
3 Tools

Choosing the right tool for the job can make a big difference in both the time taken to create the poster and the quality of the final product.

What makes a tool the ‘best’ for your circumstances depends on a number of factors:

- The features the tool has that help with poster creation
- Your experience with the tool
- The training resources available
- The cost and availability of the tool
- The availability of help and support within your college and/or department.

3.1. Poster design

The table on the next page gives a brief comparison of the main tools you might consider using to create a poster.

The majority of posters sent for printing to the IT Services printing service are created in *PowerPoint*. 
<table>
<thead>
<tr>
<th>Tool</th>
<th>Platform</th>
<th>Cost</th>
<th>Ease of use</th>
<th>Can create posters bigger than A2</th>
<th>Auto-flow between text boxes</th>
<th>Graphics handling</th>
<th>Text wrap around graphics</th>
<th>Layers</th>
<th>Drawing tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adobe InDesign</td>
<td>Windows, Mac</td>
<td>Expensive</td>
<td>Has a learning curve</td>
<td>Y</td>
<td>Y</td>
<td>Excellent</td>
<td>Yes</td>
<td>Many</td>
<td>OK, integrates well with Illustrator and Photoshop</td>
</tr>
<tr>
<td>PowerPoint</td>
<td>Windows, Mac</td>
<td>Part of MS Office</td>
<td>Uses the MS Office interface</td>
<td>Y</td>
<td>N</td>
<td>Good</td>
<td>No</td>
<td>Multiple, only one fixed</td>
<td>Good</td>
</tr>
<tr>
<td>Impress</td>
<td>Windows, Mac, Linux</td>
<td>Free, part of Open Office</td>
<td>Similar to PowerPoint 2003</td>
<td>Y</td>
<td>N</td>
<td>Good</td>
<td>No</td>
<td>Multiple, only one fixed</td>
<td>Good</td>
</tr>
<tr>
<td>Publisher</td>
<td>Windows</td>
<td>Inexpensive/part of MS Office</td>
<td>Uses the MS Office interface</td>
<td>Y</td>
<td>Y</td>
<td>Good</td>
<td>Some</td>
<td>Multiple, only one fixed</td>
<td>Good</td>
</tr>
<tr>
<td>Word</td>
<td>Windows, Mac</td>
<td>Part of MS Office</td>
<td>Uses the MS Office interface</td>
<td>N</td>
<td>N</td>
<td>Average</td>
<td>Some</td>
<td>Multiple, none fixed</td>
<td>Good</td>
</tr>
<tr>
<td>Keynote</td>
<td>Mac</td>
<td>Part of iWorks</td>
<td>Standard Mac interface</td>
<td>N</td>
<td>N</td>
<td>Good</td>
<td>No</td>
<td>Multiple, only one fixed</td>
<td>Good</td>
</tr>
<tr>
<td>Pages</td>
<td>Mac</td>
<td>Part of iWorks</td>
<td>Standard Mac interface</td>
<td>Y</td>
<td>Y</td>
<td>Good</td>
<td>Yes</td>
<td>Multiple, only one fixed</td>
<td>Good</td>
</tr>
</tbody>
</table>
3.2. Image editing

Most of the tools mentioned in the previous table include some image manipulation features. For example, PowerPoint can apply effects such as cropping, rotating, resizing and colouring images.

For more sophisticated image manipulation, for example retouching or enhancing part of an image, you will need to use an image editor. Two that we recommend are:

**Photoshop (Windows, Mac)**

This is the most widely used and respected image editing application. It is expensive, although there is a cut-down version, Adobe Elements, which retains the most useful editing features, but is significantly cheaper.

**GIMP (Windows, Mac)**

GIMP is an open source editing application. Photoshop has the edge in the number of features and ease of use, but GIMP is a very close second.

**iPhoto (Mac)**

*iPhoto* is part of the *iLife* suite on a Mac. It is not a full featured image editing tool (for example it does not implement layers), but it does provide a wider range of tools than those built in to most poster creation applications.

The IT Learning Programme runs introductory sessions covering these tools.

3.3. Data analysis

Some poster creation tools, such as PowerPoint, include the ability to produce charts and graphs from data. Generally it is more effective to analyse your data in your preferred data analysis tool (for example Excel, SPSS, MatLab) and then export the resulting charts and graphs as images.

You need to take care that the images are of sufficient resolution for use on a large poster. Image resolution and the design of charts and graphs are covered in the next section.
4 Using graphics

Images and diagrams will typically occupy about 40% of your poster. They are an opportunity not only to get across a lot of information (a picture often IS worth a thousand words), but also to make your poster interesting and eye-catching.

Graphics on the poster must be large enough to be seen and understood by someone standing about a metre away. They therefore need to be well chosen and of good quality.

4.1. Images

There are two broad types of image:

- Vector images
- Bitmap images

4.1.1. Vector images

A vector image is made up of lines and shapes. These are described within the program using a series of mathematical formulas. The advantage of this is that lines and shapes scale very effectively; if you want a larger circle, the formula for a circle can be used to redraw it perfectly.

Diagrams drawn in your poster creation tool are usually vector images and so will resize well.

Vector images tend to take up very little storage space, and so don’t add much to the file size of a poster.

4.1.2. Bitmap images

Bitmaps are images made up of a large collection of very small, fixed size dots (usually called dots on paper, or pixels on screen), which from a distance merge together to give an image. When you want to resize a bitmap image the software needs to decide which dots to leave out (if you are shrinking the image) or what sort of dots to insert (if you are enlarging the image). This often leads to a reduction in the image quality.

Images from scanners and cameras will be bitmaps and so should be resized with care on your poster. Reducing an image in size usually gives fewer problems than increasing it.

There are a number of different formats for bitmap images, but for our purpose here we can treat them as the same. The important consideration is the pixel dimensions of the image.

For good quality printing, you should aim for at least 200 dots per inch (dpi), i.e. 80 dots per cm, but preferably 300 dpi (120 dpcm).

You can find the number of pixels in an image very easily:

In Windows you simply open the My Computer window, navigate to the folder containing the image, and move your mouse pointer to rest over the image. The pixel dimensions will appear in a small information box over the image.

On a Mac, open a Finder window, CTRL+click on the image and choose Get Info from the menu that appears. The pixel dimensions are listed under the More Info section of the Info panel that appears.

Once you have found the pixel dimensions, the calculation is simple:
Divide by 200 (or 300 for better quality) to get the image dimensions in inches, or
Divide by 80 (or 120 for better quality) to get the image dimensions in cm

The dimensions you calculate are a guide to the maximum size at which you can use the image on the poster. It is only a guide; it also depends on the quality of the original image – for example how ‘sharp’ the image is in terms of focus.

4.1.3. Sourcing your images

Digital cameras
Images from digital cameras are bitmap images (usually in the JPEG format). The resolution rule described above applies, and so to give you the most flexibility you should use the highest resolution setting on the camera. Check the camera manual for details.

Scanning
When scanning an image, you will have the option of choosing the final resolution of the image. To determine this (we will work in inches here):

Decide the dimensions of the image on the poster
  e.g. 6 in

Calculate the number of dots you therefore need based on 200 dpi (300 dpi for high quality)
  e.g. 6 x 200 = 1200

Take the original image dimensions
  e.g. 8 in

Divide the required number of pixels by the original dimension to calculate the scanning resolution
  i.e. 1200 /8 = 150 dpi

This gives you the scanning resolution to use, i.e. 150 dpi.

You may not be able to set the exact, calculated, scanning resolution in the scanner’s software, but choose the closest match.

Academic collections
Your faculty library staff should be able to give you details of image libraries that specifically cover your topic area. In particular, the University subscribes to a number of image collections such as:
  www.artstor.org
  www.bridgemaneducation.com

Stock photo collections
These are collections of images that are made available for use for a small fee, typically of the order of £1 per image but dependent on size and quality.
Examples are:
  www.123rf.com
  www.istockphoto.com
  www.fotolia.co.uk

The range of topics covered is wide, but the images tend not to be particularly technical or academic.

Free collections
These are collections of images that can be freely used, although an acknowledgement usually has to be included. Examples are:
  www.morguefile.com
Photo sharing applications

There are a number of web sites that allow registered users to upload their own images to be shared with others. One of the better known is Flickr at www.flickr.com

Although these images are copyright, some contributors use the creative commons licence so that their images can be used within certain limitations.

Generic search engines

Search tools such as Google, Yahoo!, Bing or Ask allow you to search for images on the web. All images found using this method are copyright unless stated otherwise and so cannot be used without permission.

Note: Most of the images from Internet based sources are meant for use on-screen, mainly in web pages and so the resolution may not be good enough for printing large on a poster.

4.1.4. Copyright

You need to be careful that you do not infringe the copyright of the owners of images that you use. If the source does not state the conditions of use you should assume that you cannot use the image without first contacting the owner and getting their permission.

Some images are made available under a Creative Commons agreement. For more details about the Creative Commons licences and what each allows, visit www.creativecommons.org.uk

It would be embarrassing at a prestigious conference to be accused of infringing copyright.

The Creative Commons website also has a search tool that will search particular web resources for creative commons licenced material:

search.creativecommons.org

4.1.5. Placing images

Most poster creation programs will allow you to place images anywhere on the poster. However, programs with full desk top publishing features such as InDesign and Publisher allow you to flow text around inserted images.

If your program does not support text flow around images (PowerPoint does not), you may have to resort to using multiple text boxes to simulate the effect when needed.

By default, images are inserted with their defined shape (usually rectangular) and at a size that is determined by their size in pixels and their resolution in dots per inch. These values are held within the image, but not all poster creation applications respect the values. You may find that images are inserted at a size that you were not expecting.

You will be able to resize the image, usually by clicking and dragging an image corner. Remember that you should not exceed your calculated maximum size on the poster based on a printing resolution of about 200 dpi (80 dots per cm).

When resizing an image, take care not to distort it. Most applications will preserve the aspect ratio of an image if you hold down the SHIFT key while clicking and dragging an image corner.

Most applications allow you to insert an image into a shape (such as a circle or an ellipse) which can add interest and individuality to your poster.
4.2. Diagrams

You will probably already be familiar with creating diagrams for papers and articles. Bear in mind that visitors tend to spend much less time with a poster than they might spend reading an article. Therefore your diagrams need to be easy to interpret quickly.

4.2.1. Creating diagrams

Most poster creation tools include features for drawing diagrams. Some, such as PowerPoint, include some pre-designed diagrams that you can customise.

You will also find that the drawing tools in each application are very similar (in Word, PowerPoint and Excel they are exactly the same), enabling you to:

- Draw lines and simple shapes
- Fill shapes with colour and images
- Group diagram elements
- Resize and move diagrams
- Include text and annotations

When designing your diagrams, you must remember that they have to be easy to see from about a metre away. This means that the lines on the diagrams will need to be heavier, and any text annotations need to be readable.

When choosing colours, you should use the poster colour scheme for underlying elements such as labels, and distinctive colours to draw attention to important parts of the diagram.

Most poster design applications create diagrams in vector format so they will resize very well.

4.2.2. Importing diagrams

If you have a preferred drawing tool, or diagrams already created in another application, you may find that you can import them into your poster creation application. This is certainly the case with the Microsoft Office programs.

If your poster creation application shares a common format with your diagramming application then you may find that copy and paste is successful. If this is not the case then you will need to export your diagram, saving it in a format that you can then import into your poster.

Ideally you should export in a vector format; however it can sometimes be difficult to find a format that both applications share. On a Windows platform the most likely choice is the Windows Metafile Format (WMF), or possibly Encapsulated Postscript (EPS). EPS is also widely supported by Mac based applications.

More likely, you will have to export the diagram as a bitmap image (probably in the JPEG format). If this is the case, make sure you export it at the highest quality so that you can have the diagram as large as necessary on the poster.

4.3. Equations

Some poster creation programs, such as PowerPoint, include an equation editor; however these tend to have quite limited features. Their one advantage is that you can size the equation to be as large as you want and still retain good quality.

If yours is a discipline that requires equations, you probably already have a preferred equation editor. If not, you should investigate the various
implementations of the *LaTeX Equation Editor*. There are a number, and you should be able to find one for your type of computer.

You are unlikely to be able to copy and paste effectively between your equation editor and your poster application and so you will need to save the equation in a common format.

Ideally this will be a vector format (see above). If it is a bitmap format (such as JPEG) then choose the highest resolution available.

Some equation editors will prefer to export equations as Adobe Acrobat PDF files. These are a good compromise, however inserting PDFs into a *PowerPoint* file on Windows is not straightforward (it is more so on a Mac). A bitmap version may be easier to manage.

### 4.4. Charts and graphs

If you have data to present on a poster, your first choice should be to display them as a chart or graph; large tables of data are rarely an effective use of poster space.

You can create simple charts and graphs inside many poster design applications, but for more complex data representations, it is probably easier to create these in a specialist data analysis application. Once created, you can export the chart and then import it into the poster.

The same issues apply here as for diagrams and equations. Vector formats are preferable, but if you have to use a bitmap version as the shared format, then the highest resolution should be used.

Remember, you will need at least 200 dpi (80 dots per cm) just as you do for images.

If you are using *PowerPoint* to create your poster and *Excel* for your data analysis, you will find that copy and paste can often produce good results.

#### 4.4.1. Chart design

Simplification is the key to producing effective charts and graphs for a poster.

Think carefully before taking a graph created for a report and reusing it on a poster.

For a report or article you may need to incorporate features in your graphs to help readers interpret your data in detail; that is rarely necessary on a poster. Charts and graphs on posters are best used to show trends and outliers in your data.

To make the chart or graph easy to read, you should remove all unnecessary ‘furniture’. For example, Excel tends to add grid lines and a shaded background, both of which are generally unnecessary:

### 4.5. Quick Response (QR) codes

A Quick Response (QR) code is a two-dimensional bar-code; you will have seen these on commercial posters and advertisements. These can be used in many different ways, but commonly they are an easy way to direct visitors to a web site for more information – the visitor points their phone or hand-held device at the QR code and it translates it into a web address and automatically opens up the web page (providing they have access to the internet).

There are a number of sites that enable you to create QR codes, for example [www.qrstuff.com](http://www.qrstuff.com)
**Figure 6** A typical Excel generated chart

With a little bit of work, we can make the chart much more suitable for a poster:

**Figure 7** An improved version of Figure 6 for a poster
5 Using Text

One of the most difficult things to do when creating a poster about your own work is deciding what to leave out! It is tempting to fill the poster with text explaining the topic in detail.

Remember that on a poster we generally expect only 20-25% of it to be text.

5.1. Font sizes

It is important that your poster can be read from a distance of about a metre. Experience has shown that this means that the following font sizes are a good starting point:

<table>
<thead>
<tr>
<th>Main title</th>
<th>72+</th>
</tr>
</thead>
<tbody>
<tr>
<td>The title should be readable from much further away than 1m; you need to be able to attract the attention of people as they wander past.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sub titles</th>
<th>54+</th>
</tr>
</thead>
<tbody>
<tr>
<td>Headings and subtitles will often give structure to your poster and so they need to be easy to identify.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Text</th>
<th>30+</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is the text of the main body of the poster</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sub text</th>
<th>20+</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information that needs to be available, but is not important to the understanding of the topic, does not have to be readable from 1m, but large enough that it can be read without getting too close</td>
<td></td>
</tr>
</tbody>
</table>

The above values are very much a guideline – you should vary them as necessary for your poster, usually upwards, but always maintaining the readability of the text.

Also be aware that the same point size in different fonts often translates to very different physical sizes. The values given are typical for a 'standard' font such as Arial, Times Roman, Trebuchet, Georgia, etc.

5.2. Fonts

There are two broad categories of font: serif and sans-serif. Serif fonts have decoration at the end of character strokes, sans-serif don’t.

There is debate about whether it is easier, on a poster, to read a sans-serif font such as Trebuchet as opposed to a serif font such as Georgia. Most successful posters opt for a sans-serif font.

Use your chosen font consistently. You can add emphasis by making characters bold or italic. Underlining is rarely effective; it makes the text look cluttered, and so should be avoided.
You might choose to use one font for the body text and a different font for your titles. If so, choose a font which is clearly different to the main body text font otherwise it looks as though you mistakenly used the wrong font!

It can sometimes be effective to use a serif font for the headings and a sans-serif font for the body text.

5.3. How much text?

Based on the rule of thumb of about 20-25% of the poster being text, and the font size needed for the text to be readable, you will find that on an A1 or A0 poster you will have room for about 400-600 words.

You should avoid the temptation to fit more words on a larger poster; visitors will only be willing to spend a few minutes with your poster, and more than 600 words will take too long to read.

It can be difficult to read large blocks of text when standing at a poster, so:

- Have a maximum of 10-12 words per line. Avoid having lines of text that stretch across the full width of the poster.
- Restrict blocks of text to 50-100 words, separating blocks with white space or graphics.

5.4. Managing text boxes

Rather than placing the text directly on to your poster, it is better to create boxes for your text which can be resized and repositioned to suit your poster design.

Ideally, your poster creation application should enable you to link one text box with another. This means that when there is too much text for one box, it automatically flows into the next. Unfortunately, few of the tools commonly used have this feature, in which case you will have to manage the distribution of text between text boxes by hand.

Usually your text boxes will be rectangular but you can also use other shapes, particularly circles and ellipses, to good effect.

A strategy that works well in most poster creation tools is to add your preferred shape, fill the shape with your chosen colour, and then convert the shape into a text box. This way your text will wrap to the shape outline.

5.4.1. Using text from elsewhere

Copy and paste of text between applications usually works well, and so you should be able to copy existing text into a text box. However, if you are using applications which understand each other’s formatting conventions, you may find that the text formatting is also copied; this is rarely what you want.

Most applications have the option to paste plain text, or remove any text formatting. It is best to start with plain text and then apply the formatting that is used elsewhere on the poster.

5.5. Using Tables

Large tables are not a good way of presenting information in a poster – where possible table data should be presented as a chart or graph.

If you do use a table, the same font size rules apply, any text that is important should be readable from a distance. You might also find it helps to ‘band’ the table to make it easier to interpret:
<table>
<thead>
<tr>
<th>Year</th>
<th>Government</th>
<th>Industry</th>
<th>Private Nonprofit</th>
</tr>
</thead>
<tbody>
<tr>
<td>1983</td>
<td>6156</td>
<td>4212</td>
<td>432</td>
</tr>
<tr>
<td>1984</td>
<td>7011</td>
<td>4797</td>
<td>492</td>
</tr>
<tr>
<td>1985</td>
<td>7695</td>
<td>5265</td>
<td>540</td>
</tr>
<tr>
<td>1986</td>
<td>7950</td>
<td>6300</td>
<td>750</td>
</tr>
<tr>
<td>1987</td>
<td>9010</td>
<td>7140</td>
<td>850</td>
</tr>
<tr>
<td>1988</td>
<td>9690</td>
<td>8360</td>
<td>950</td>
</tr>
<tr>
<td>1989</td>
<td>10710</td>
<td>9450</td>
<td>840</td>
</tr>
<tr>
<td>1990</td>
<td>11730</td>
<td>10580</td>
<td>690</td>
</tr>
</tbody>
</table>

Figure 8 An example of a ‘banded’ table
6 Using Layers

The more sophisticated poster creation applications, such as *InDesign*, allow you to have multiple layers. Each layer can be locked and/or hidden individually.

Layers can be a useful tool when laying out your poster. Images and graphics can be placed on one layer, text boxes on another, the background on another and any grid or guidelines on yet another. By locking all layers except, say, the text box layer you can interact with the text without accidentally moving or changing anything else on the poster.

Presentation tools such as *PowerPoint* and *KeyNote* only have two layers: foreground and background. The background layer is accessed through the slide master – anything that is on the slide master is placed in the background of every slide or in our case our poster.

If you have only two layers, then typically the background layer would be used to hold any design elements (images, shapes, etc.) for the background of your poster.

6.1. Layering text and graphics

Within a layer, you also have the facility to arrange the stacking order of overlapping elements. This can be useful when creating complex diagrams, for example allowing a text box containing a diagram label to float over a part of the diagram.

Some tools, for example *PowerPoint*, allow you to change the transparency of certain elements such as shapes and this, combined with the ability to overlap, can help produce interesting effects on diagrams.
7 Proofing and printing

You will spend many hours working on your poster, often to a tight deadline. Make sure that you allow sufficient time for proofreading – and the inevitable corrections that follow – and for printing.

7.1. Proofreading

Proofreading is important. Your visitors will be quick to spot spelling and grammatical errors and they can detract from the poster content and quality.

You, as the author, are not always the best person to spot your own mistakes and it is best to ask a colleague to proofread for you.

All poster creation tools have a spell-checking feature. Make sure that this is turned on, or if it is not automatic, make sure that you run the spell-checker frequently.

Do not ignore highlighted misspellings. You may have some technical terms that your software’s dictionary does not recognise and so highlights as misspelt. You should carefully check the spelling of these terms and then add them to the dictionary (often through a right-click of the mouse). This way you know that ANY highlighted words are errors that need to be fixed.

If there is a grammar checking feature, use it. It may not be correct in its suggestions, but at least it will get you to think about what you have written.

7.2. Evaluating your poster

Proofreading is important, but you also need to take a step back from your poster and evaluate it as a whole.

Again, you are probably not the best person to do this, so enlist the help of a colleague. Below, there is a simple form (based on one created by George Hess of North Carolina State University) that you can give to your colleague to prompt them to provide some feedback.

The scoring is not meant to be rigorous; it is simply a means by which you can have a discussion about possible improvements that could be made to your poster.

It is not useful to print the poster at full size for evaluation. Either:

- Project the poster large on to a screen in a seminar room or classroom

Or

- Print out an A4 or A3 version. Most poster creation applications will allow you to print at a reduced size. Alternatively save the poster as a PDF. PDFs can be printed at any size.

Some printers also have a feature where you can print A4 panels of a larger document which you can then layout to get an overview of the poster at actual size.
<table>
<thead>
<tr>
<th>POSTER EVALUATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author(s)</td>
</tr>
<tr>
<td>Poster Title/No</td>
</tr>
<tr>
<td>Evaluated by</td>
</tr>
</tbody>
</table>

**SCORING (if you must!)**

<table>
<thead>
<tr>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unacceptable/Missing</td>
<td>Present, some failings</td>
<td>Acceptable</td>
<td>Good</td>
</tr>
</tbody>
</table>

**CONTENT**

<table>
<thead>
<tr>
<th>COMMENTS</th>
</tr>
</thead>
</table>
| Clear entry point  
*Where do I start?* |
| Logical organisation  
*Where do I go?* |
| Clear objectives  
*What will I get?* |
| Clear summary  
*What have I seen?* |
| Contact details  
*Where can I find out more?* |
| Information density  
*Did I run out of time?* |

**DESIGN**

<table>
<thead>
<tr>
<th>COMMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use of colour</td>
</tr>
<tr>
<td>Use of images</td>
</tr>
<tr>
<td>Use of fonts</td>
</tr>
<tr>
<td>Use of alignment</td>
</tr>
<tr>
<td>Use of white space</td>
</tr>
<tr>
<td>Balance of text and graphics</td>
</tr>
<tr>
<td>Consistency</td>
</tr>
<tr>
<td>Innovation and impact</td>
</tr>
</tbody>
</table>

**TOTAL SCORE**
7.3. Printing

There are a number of places around the University that will print large posters much more cheaply than commercial printers. You should ask in your college or department which is the preferred printing route.

If you don’t have a local printing facility, you can get your poster printed at IT Services. Details are on the web pages at [www.it.ox.ac.uk](http://www.it.ox.ac.uk) (Search for Printing Service).

Printing a large poster does take time, and yours may not be the only poster in the queue, so make sure that you allow sufficient time, ideally 24-48 hours.

It is possible to get your poster printed on other materials than paper. For example, you could print on to cloth. This could be a good option if you have to transport your poster as carry-on luggage on a flight, but the weave of the cloth can reduce the apparent resolution of the images and text. You would certainly need to get a sample before committing to this route.

7.3.1. Versions, fonts and images

If you decide to give the print room a copy of your poster in its native format (PowerPoint, InDesign, KeyNote, etc.) then there are potential pitfalls.

Make sure that the print room uses a compatible version of the software that you used, particularly if you are using a recently released version.

If you are using an uncommon font, make sure that you include the font with your poster file. The Windows version of PowerPoint allows you to embed fonts within the poster file. InDesign allows you to create a ‘package’ that includes the font files.

If you are using a poster creation application that may link to images rather than embed them in the poster, you need to include the image files separately. InDesign is the most common application that can use links in this way.

7.3.2. Producing a PDF version

You can avoid all of the above problems by creating a PDF version of your poster. Most poster creation applications enable you to save as PDF. If you can’t save directly as a PDF there are a number of programs available that will give you a PDF ‘printer’ that creates a file when you ‘print’ to it.

The standard PDF creation program is Adobe PDF Creator, but it needs to be purchased. There are a number of free programs including:

- **PDFCreator** at [sourceforge.net/projects/pdfe creator/](http://sourceforge.net/projects/pdfcreator/)

Most print rooms will be happy to print your poster from a PDF file.

7.3.3. Colours

It is difficult to match printed colours to on-screen colours without calibrating both the monitor and the printer – a time-consuming operation. If a particular colour is important, then you should liaise with the print room and arrange for some trial prints.
8 Delivering the poster

With the hard work finished, you need to spend just a little time thinking through how you will get the poster to the conference and how you will present it.

8.1. Transporting and fixing

Invest in a sturdy poster tube. If you are flying to the conference, you may not be able to carry the tube on board the plane, so it should be substantial enough to withstand a baggage handler!

You may find it a useful investment to have your poster laminated in clear plastic. This only costs a few pounds, but can provide extra protection particularly in a humid environment which might affect the paper and/or inks. Not all print rooms offer lamination. The Physics Media Unit is able to laminate posters up to A0 size.

Another option may be to print the poster on to material (see above).

Conference organisers should provide a means for fixing your poster to the supplied boards. BluTak works on smooth surfaces, but for cloth you probably need sticky Velcro -type pads. You might decide to take your own small supply of both.

8.2. The poster session

Conferences usually have a poster session when you are expected to be near your poster and ready to answer questions from interested visitors.

It is worth having in your mind two ‘tours’ through your poster:

   - The two minute tour, covering the essentials for those visitors with limited time.
   - The ten minute tour, addressing the poster topics in more depth for those particularly interested.

8.3. Poster handout

Most posters are left up for the duration of the conference, and you won’t be there all the time to give your poster tour. It can be useful to print an A4 version of your poster – in colour if you can. You can use this as a hand-out for visitors, and leave any spares in a small bundle near the poster for when you are not there.

You may even choose to put extra information on the back of the poster hand-out.

You will find that many visitors will use a mobile phone camera to take a photo of your poster: another reason to make the important elements easy to read from a distance.
9 The workshop

Now is the time for you to create a poster. The table overleaf lists the steps you should follow.

Each step describes briefly what the aim of that step is. It has a reference to the relevant description in the text and also to one or more ‘How To...’ sheets later in the book.

You can approach the workshop in one of two ways:

If you have your own resources for your poster, you should use these to complete each step.

If you do not yet need to create your own poster, or if you do not have your resources with you, you can use the files and resources referred to in the ‘Resources column’. These will be found in the folder identified by your teacher (or in your own folder if you downloaded them from WebLearn).

You may already have the skills to carry out some of the steps, in which case you may not need to refer to the ‘How To...’ sheets. If you don’t think a step is relevant for your poster, then leave it out.

If you need advice, ask the workshop leader or one of the demonstrators.
<table>
<thead>
<tr>
<th>Step</th>
<th>Topic Ref.</th>
<th>‘How To…’ Reference</th>
<th>Page</th>
<th>Resources available if you don’t have your own</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>Poster sketch (see below)</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>How to create a blank slide</td>
<td>p33</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>How to change the page orientation and size</td>
<td>p34</td>
<td>Poster specification sheet</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>How to set up a grid and add guides</td>
<td>p35</td>
<td>Poster sketch (see below)</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>How to change the poster background colour</td>
<td>p37</td>
<td>Make your own choice of background and background design elements</td>
</tr>
<tr>
<td></td>
<td></td>
<td>How to add a background image</td>
<td>p38</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>How to add design elements to the background (master) layer</td>
<td>p39</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>How to add a trim border</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>How to insert placeholders (shapes)</td>
<td>p40</td>
<td>Poster sketch</td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>How to convert a shape to a text box</td>
<td>p41</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>How to add text</td>
<td>p42</td>
<td>“Shaping the Desert: Time and Clime” Use your own contact details and affiliations</td>
</tr>
<tr>
<td></td>
<td></td>
<td>How to format text</td>
<td>p43</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>How to insert existing text</td>
<td>p44</td>
<td></td>
</tr>
<tr>
<td>Step</td>
<td>Task</td>
<td>Section</td>
<td>Steps</td>
<td>Notes</td>
</tr>
<tr>
<td>------</td>
<td>------</td>
<td>---------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>9</td>
<td>Insert required images</td>
<td>4.1</td>
<td>How to check image resolution How to insert an image How to insert an image into a shape</td>
<td>p45 p46 p47</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Images in class folder: Monumentvalley.jpg Geological_time_spiral.png ox_brand_cmyk_rev.eps</td>
</tr>
<tr>
<td>10</td>
<td>Crop and adjust images if necessary</td>
<td></td>
<td>How to resize, crop and position an image</td>
<td>p48</td>
</tr>
<tr>
<td>11</td>
<td>Insert the required diagrams</td>
<td>4.2</td>
<td>How to use a PowerPoint diagram How to create a diagram How to insert an image</td>
<td>p49 p51 p46</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Diagram sketch (see below)</td>
</tr>
<tr>
<td>12</td>
<td>Insert the required charts</td>
<td>4.4</td>
<td>How to create a chart How to adjust a chart’s design How to insert an existing chart</td>
<td>p52 p53 p54</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Chart contained in class folder: Desert_poster_chart.xls</td>
</tr>
<tr>
<td>13</td>
<td>Insert the required equations</td>
<td>4.3</td>
<td>How to create an equation How to insert an image</td>
<td>p55 p46</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Supplied equation (see below)</td>
</tr>
<tr>
<td>14</td>
<td>Insert the required tables</td>
<td>5.5</td>
<td>How to create a table How to adjust a table How to insert an existing table</td>
<td>p56 p57 p58</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Table of temperature extremes (see below)</td>
</tr>
<tr>
<td>15</td>
<td>Convert remaining shapes to text boxes</td>
<td></td>
<td>How to convert a shape to a text box</td>
<td>p41</td>
</tr>
<tr>
<td>16</td>
<td>Adjust the text behaviour of text boxes</td>
<td>5.1 5.2 5.3 5.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Add the text</td>
<td>5.3</td>
<td>How to add text How to insert existing text</td>
<td>p42 p44</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Lorem Ipsum.txt (text only) Lorem Ipsum.doc (Word)</td>
</tr>
<tr>
<td>18</td>
<td>Format and adjust the text as necessary, aiming for consistency</td>
<td>5.1 5.2</td>
<td>How to format text</td>
<td>p43</td>
</tr>
<tr>
<td>19</td>
<td>Print out a proof copy of the poster</td>
<td>7.3</td>
<td>How to print a poster proof</td>
<td>p59</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>20</td>
<td>Evaluate the poster</td>
<td>7.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Make final adjustments</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Create a PDF of the poster for printing</td>
<td>7.3.2</td>
<td>How to create a PDF for printing</td>
<td>p60</td>
</tr>
</tbody>
</table>
9.1. **Class Resources**

If you do not have your own resources with you, can use the following:
De Martonne’s Aridity Index:

\[ I_a = \frac{P}{T + 10} \]

<table>
<thead>
<tr>
<th>Extremes</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum sand temperature (Port Sudan)</td>
<td>84 °C</td>
</tr>
<tr>
<td>Maximum air temperature (Sahara)</td>
<td>58 °C</td>
</tr>
<tr>
<td>Maximum air diurnal range (Sonoran)</td>
<td>40 °C</td>
</tr>
<tr>
<td>Maximum sand diurnal range (Kara Kum)</td>
<td>120 °C</td>
</tr>
</tbody>
</table>
Create a blank slide (poster!)

When you create a new presentation, PowerPoint likes to give you a title slide as the first slide. We need a blank slide for our poster.

Follow these steps:

1. Open PowerPoint 2010
2. Select the **File** tab of the ribbon.
   Select **New** to display the Available Templates and Themes list.
   Click on Blank Presentation and then click **Create**
3. Select the **Home** tab of the ribbon.
4. In the Slides category, click on **Layout** to display the Layout panel
   Click on Blank
Change the page orientation and size

It is important to do this at the start; if you change the size or orientation later, you will need to re-work the layout of your poster.

Follow these steps:

1. Select the Design tab of the ribbon.
2. Click on Page Setup to display the Page Setup dialog.
3. Click into the Slides sized for box and select Custom.
4. Enter the width and height into the Width and Height boxes.
   Common sizes are given in section 2.2
   Notice that the Orientation setting on the right of the dialog will change to reflect the dimensions you have entered.
   Click OK.
Add a trim border to the poster

Your poster will be printed on a large roll of paper and then trimmed to the correct size. To make sure it gets trimmed correctly, it is helpful to print a thin ‘trim line’ at the very edge of the poster. This can be particularly important for posters on a white background, where there is a risk that your carefully considered (blank) border gets trimmed off.

Follow these steps:

1. Select and click to display the slide masters and Slide Master ribbon.
2. If the Blank Layout slide master is not selected, scroll down the list on the left and select it.
3. Click to display the Insert ribbon.
4. Click to display the Shapes collection. Select the Rectangle shape.
5. Click and drag a rectangle the full width and height of the poster (slide).
6. Click .
7. Click and select the No Fill option.
8. Click and change Weight to ½ pt.
9. Click and click Master View.
Setup a grid and guidelines

Alignment of elements on your poster is an important aspect of the design: ‘Everything should line up with something’. Using a grid and guidelines can help. Turning on the grid places a series of dots at the main grid intersections. These are not displayed in the final poster.

You can position as many horizontal and vertical guides as you want. You can use these to produce your own grid in preference to the default grid.

Follow these steps:

1. Select the **Home** tab of the ribbon.
2. In the **Drawing** group, click on **Arrange**
   click on **Align**
   click on **Grid Settings**
3. In the **Grid and Guides** dialog, choose to display grid and/or display drawing guides by clicking the boxes.
4. Put a tick in the **Snap objects to grid** box.
   Change the Spacing to 0.1 cm. Even if you don’t display grid dots, objects will still ‘snap to’ the grid.
   Click **OK**.
5. If you have chosen to display drawing guides, two will be placed in the middle of the poster.
   To add extra guides, hold down the **Ctrl** key and click and drag one of the guides. When you release the button, the new guide is created.
   To reposition a guideline, click and drag it.
   To remove a guideline, click and drag it to the edge of the poster.
Change the poster background colour

White works very well for a poster background, but you can have any colour you want. Be careful with gradients; if the two gradient colours are very different, choosing a text colour will be difficult.

Follow these steps:

1. Select the Design tab of the ribbon.
2. In the Background group, click on and click on Format Background.
3. In the Format Background dialog, click on the Fill category at the left.
4. For a single colour, select Solid fill and click on Color to choose a suitable colour.
   Click Apply to All.
5. For a gradient, select Gradient fill.
   Choose a Type, Direction and Angle.
   Gradient stops define where the colours change.
   Click in the Stop box, choose a Stop and then choose a Stop position and Color.
   You may need to experiment to get the effect you want.
   Click Apply to All.
Add a background image

You can add an image as a background, but take care it does not detract from your content. You are unlikely to find one with the resolution for high quality printing, so you will probably need to ‘disguise’ the resolution by using an artistic effect.

Follow these steps:

1. Select the Design tab of the ribbon.
2. In the Background group, click on and click on Format Background.
3. In the Format Background dialog, click on the Fill category at the left. Select the Picture or texture fill option. Click on File to display the Insert Picture dialog. Select the picture and click on Insert. You can adjust the Stretch options and Transparency as needed.
4. You can experiment with other changes to the picture using the Picture Corrections or Picture Color or Artistic Effects options. For example, select Picture Color and then click on Recolor Presets. Choose a Recolor option. Click Apply to All.
Add design elements to the background

You can add shapes and other elements to the background using the ‘slide’ master. These will show through to the poster, but being on the background can’t be changed accidentally when dragging and positioning text and graphics.

Follow these steps:

1. Select the View tab.
2. Click on Slide Master in the Presentation Views group.
3. The master slides appear at the left. There are likely to be several.
4. Scroll down the list of masters and identify the Blank Layout master.
   Click on it to select it.
5. Any shapes, images or text that you place on the Master will ‘show through’ to your poster.
   When you have finished, click on the Slide Master tab and click on Close Master View in the Close group.
6. You can return to the Master view at any time to adjust the background without affecting the poster elements in the foreground.
Insert placeholders

When starting to layout your poster, you should add placeholders for your text, images, etc. which you fill with content later. The easiest item to use as a placeholder in PowerPoint is a shape.

Follow these steps:

1. Select the **Insert** tab of the ribbon.
2. In the **Illustrations group**, click on **Shapes** to display the shapes panel.
3. Click on the shape you want as a placeholder. Most solid shapes can later hold text or images, but usually you will select a rectangle.
4. The mouse cursor will change to a cross hair. Click and drag anywhere on the poster to create a shape of roughly the correct size.
5. Resize the shape by clicking and dragging an edge or corner. Move a shape by clicking and dragging inside the shape. Use the grid and/or guides on your poster to help with sizing and positioning.
6. Select a shape by clicking on it, then click on the **Format** tab to access the formatting tools if necessary.
Convert a shape to a text box

When you are ready to place text into a placeholder (shape), you can easily convert it to a text box.

Follow these steps:

1. Right click on the shape and choose Format Shape from the pop-up menu.
2. In the list at the left of the dialog, select Text Box to display the Text Box options.
3. Make sure you select Do not Autofit and Wrap text in shape.
4. Select the other options as necessary. Typically you would set the Vertical alignment to Top and set the margins to 0 cm.
5. Select Fill on the left to display the Fill options. Choose Solid fill and use Color to select a colour.
6. Select the Line Color option on the left. Typically you would then select No Line.
7. Click Close

Select the tab. With the shape still selected, use the Font button in the Font group to change the font colour. Use the Align Text buttons in the Paragraph group to set text alignment.
Add text

Remember that text should only occupy about 20-25% of your poster. If you have used a shape as a placeholder, and converted it to text (see separate How To sheets), click on the placeholder and start typing. You may want to create a text box directly if you need labels for images and diagrams.

Follow these steps:

1. Select the **Insert** tab.
2. In the **Text** group, click on **Text Box**.
3. Move the mouse cursor to where you want the text box to be placed and Click.
4. Type the text. Click away from the text box when you have finished typing.
5. To adjust the behaviour of the text box, right-click anywhere in the text box and select **Format Shape**. Choose the **Text Box** option at the left of the **Format Shape** dialog. Typically you would choose the **Do not Autofit** and **Wrap text in shape** options.
6. Click **Close**
7. To edit the text, click anywhere within the text box.
8. To move the text box, click anywhere within the text box and then click and drag on the text box border.
Format text

There are two aspects to formatting text: making style changes to the container (text box, shape, etc.) and making style changes to the text itself.

Follow these steps:

1. To make format changes to all of the text in a text box, click on the text box border. When selected the border will be a solid line.

2. Select the Home tab. You can now use the Font group and the Paragraph group to make changes to all of the text contained in the text box.

3. To make changes to just part of the text, click into the text box and select the text to be changed. Again use the Font and Paragraph groups for changes.

4. To make changes to the text box container, click on the text box border. When selected the border will be a solid line.

5. Select the Home tab. You can now use the Drawing group to make changes to the text box.
Insert existing text

You should think carefully before simply taking text from a report or paper and pasting it into the poster. Sentences and paragraphs on a poster need to be shorter than those typically found in more formal documents.

Follow these steps:

1. Open your poster in PowerPoint and your text source document, perhaps in Word.
2. Select the text in your original document and copy it.
3. Switch back to PowerPoint.
   Select the Home tab.
4. If you already have a text box for the text, click into it where you want the text to be inserted.
5. If you do not have a text box ready, make sure that nothing is selected by clicking on an empty part of the slide
6. Click on
7. Look for the Paste options button that appears close to the pasted text. Click on it and select the first paste option: Use destination theme
8. You may need to modify the text box behaviour if, for example, the text has stretched an existing text box
   The Adding Text section above explains how to do this.
Check the resolution of an image

Images need to be high resolution; ideally you need at least 200 dots per inch (80 dots per cm) and preferably 300 dots per inch. So find out the how many dots wide your image is, divide by 200 (or 300), and that is an approximate limit to its width on the poster.

Follow these steps:

1. On the task bar, click on Select My Computer.
2. Make sure that the left panel is showing Tasks and Information. If it is not, click on Folders in the folder dialog toolbar.
3. Find the folder that contains your image. Click on the image to select it.
4. In the Details section at the bottom of the Tasks and Information panel, note the image dimensions. The width is given first.
5. Close the dialog.
Insert an image

When you insert an image it may not appear at the size you want. Sometimes it may even fill the entire poster! Once inserted you can change the image dimensions to what you want.

Follow these steps:

1. Select the Insert tab.
2. Click on Picture.
3. In the Insert Picture dialog, find your image and click on it.
4. Click the Format tab.
   
   The image is unlikely to be the size you want.
5. Select the tab.
   
   In the Size group change the height (or width) to the desired value.
   
   Changing one will cause the other to change to preserve the picture’s aspect ratio.
6. To crop one side of the image, click on Crop.
   
   Click and drag a crop handle to crop the image.
   
   To commit the crop, click on the Crop button a second time.
Insert an image into a shape

Most of your images will be rectangular, but you can sometimes create an interesting effect by placing images in other shapes.

Follow these steps:

1. If you already have a shape to fill, click on it. Select the tab.

2. In the Shape Styles group, click on and select Picture. In the Insert Picture dialog, find your picture, select it and click .

You have little control over how the image is inserted.
Resize, crop and position an image

You should make use of the grid and/or guides feature to help to size and position your images to fit with the overall layout of your poster.

Follow these steps:

1. To resize an image, click on it to select it.
   A set of resizing handles will appear around the image.
   Click and drag a handle to resize the image.
   Using a corner will preserve the aspect ratio of the image.

2. To crop an image, click on it to select it.
   Select the tab.
   In the Size group click on .
   Click and drag a cropping handle to crop a side of the image.
   The area to be cropped will be greyed-out. To commit the crop, click on the Crop button again.

3. To reposition an image click and drag inside the image.

4. You can have fine control over sizing, cropping and positioning through the Format Picture dialog.
   To open the Format Picture dialog, click on the Expand button at the bottom left of the Size group.
Make adjustments to a picture’s colour

You should always remember that the colours you see on the screen when you are designing your poster may not reproduce exactly when printed; this is because the colour technologies for screen and print are very different.

Follow these steps:

1. To adjust the colour of an image, click on it to select it.
   A set of resizing handles will appear around the image.
2. Select the Format tab.
   In the Adjust group click on the tab.
   Move your mouse over the correction options. You will see the correction being applied as a preview on the slide.
   Click on the required correction to apply it.
3. If you want full control over the correction options, select Picture Correction Options from the bottom of the Corrections menu.
   This will open the Format Picture dialog at the Picture Corrections section.
4. In a similar way, you can apply colour corrections by clicking on the tab in the Adjust group.
Use a PowerPoint diagram

PowerPoint has a large collection of predefined diagrams that you can adapt. There are a variety of diagram types available, and they can save you time if there happens to be one that suits your purpose. If not, you will have to resort to creating your own.

Follow these steps:

1. Select the **Insert** tab.
   In the **Illustrations** group, click on **SmartArt**.

2. In the **Choose a SmartArt Graphic** dialog, scroll through the list of diagrams.
   If you click on a diagram, details of how it should be used are displayed in the panel at the right.

3. When you have chosen the diagram you want, click **OK**.

4. The diagram is inserted in your poster.
   A dialog appears prompting you for the text for the diagram.
   Click on a blank part of the poster when you have added the text.

5. To edit the diagram, click on it to select it.
   To change the colours or styling, select the diagram, select the **Design** tab, and use the tools in the **SmartArt Styles** group.
Create a diagram

PowerPoint includes a number of shapes and drawing tools that can be used to create quite complex diagrams. You can use these in conjunction with images and text. You should group together elements of your diagram so that when it is moved or resized it doesn’t become distorted or broken up.

Follow these steps:

1. Select the Insert tab. In the Illustrations group, click on Shapes. Select a shape to add to your diagram. The cursor will change to a crosshair. Click and drag to create the shape.

2. Resize the shape with the resize handles. To keep the aspect ratio, use a corner handle and hold down the Shift key. Move a shape by clicking and dragging inside it.

3. To format a shape, click on it, select Format. Use the Shape Styles and Arrange groups to format the shape.

4. Use Bring to Front and in the Arrange group to change the layering of shapes.

5. To group diagram shapes, click on a shape, then hold down Shift while clicking on other shapes. Click on Group. Then move and resize the elements as a group.
Create a chart

PowerPoint uses Excel to create its charts. For sophisticated chart creation you may find it useful to attend one of our Excel courses.

Follow these steps:

1. Select the tab. Click on

2. In the Insert Chart dialog, scroll through and select the chart you want. Click

3. Excel will open with some placeholder data. Change the data and column/row labels as needed. Close the Excel window

4. Click away from the Chart to see how it will appear. You can resize the chart by selecting it and using the resize handles. Move the chart by clicking and dragging a chart border

5. To edit the chart data, click on the chart and select the tab. In the Data group, click on

6. To change the chart type, in the Type group click on
Adjust a chart’s design

Every aspect of a chart can be changed. Remember that it is important that you keep your charts as clean and simple as possible to avoid cluttering your poster with too much detail.

Follow these steps:

1. To make any changes to a chart you must first click on it to select it.
2. To change the chart design, click on the Design tab. Use the groups to adjust the different design aspects.
3. To change aspects of the chart layout, select the Layout tab.
4. Click away from the chart to see how it will appear on the poster.
Insert an existing chart

You may already have a chart that you want to use on your poster. Remember that charts suitable for reports and papers are not always suitable for a poster. Simplify!

Follow these steps:

1. If you have a chart as an image, you can insert it and handle it as you would any image.
2. If you have an existing Excel chart, open that chart in Excel.
3. Select the chart by clicking on it. Copy it to the clipboard (Ctrl+C).
4. Switch back to PowerPoint. Select the tab. Paste the chart using in the group.
5. Click on the paste options button at the bottom left of the pasted chart. Select one of the options:
   - Use Destination Theme: Changes the format of the chart to that of the current theme.
   - Keep Source Formatting: Keep the chart in its original format.
   - Picture: Converts the chart to a bitmap picture. Note that you won’t then be able to make any changes to the chart.
6. You can move and resize the chart using the handles and borders.

See the How To section on adjusting a chart’s design.
Create an equation

PowerPoint contains an equation editor which is adequate for simple equations. For more complicated equations (in terms of layout!), you may need to use a program such as LaTeX and then export the equation as an image for use in the poster.

Follow these steps:

1. Select the **Insert** tab. In the **Symbols** group, click on **π**.
   A text box is created for your equation.

2. As an example, type \( a = \) then click on **\( \sqrt{\)*** in the **Structures** group.
   Select the Square Root radical (the first one).

3. Click on the square placeholder and type \( b + \).

4. Click on the **\( e^x \)*** in the **Structures** group and select the **Superscript** option (the first one).

5. Click on the first (larger) square placeholder and type \( c \).

6. Click on the other square placeholder and type \( 2 \).

8. You can format the equation – for example change the font size or colour – using the standard formatting tools.

\[
\begin{align*}
\text{Follow these steps:} \\
1. & \quad \text{Select the **Insert** tab. In the **Symbols** group, click on **π**.} \\
   & \quad \text{A text box is created for your equation.} \\
2. & \quad \text{As an example, type } a = \text{ then click on **\( \sqrt{\)*** in the **Structures** group.} \\
   & \quad \text{Select the Square Root radical (the first one).} \\
3. & \quad \text{Click on the square placeholder and type } b + \text{.} \\
4. & \quad \text{Click on the **\( e^x \)*** in the **Structures** group and select the **Superscript** option (the first one).} \\
5. & \quad \text{Click on the first (larger) square placeholder and type } c \text{.} \\
6. & \quad \text{Click on the other square placeholder and type } 2 \text{.} \\
8. & \quad \text{You can format the equation – for example change the font size or colour – using the standard formatting tools.}
\end{align*}
\]
Create a table

Large tables of data are not effective in posters – you should consider using some graphical representation. However a short table could be used to, perhaps compare properties or features. Remember that font size rules of thumb apply to text in tables.

Follow these steps:

1. Select the **Insert** tab.
2. Click on **Table** in the **Tables** group and drag your cursor over the grid to select the number of rows and columns and then left-click to insert the table.
3. The table is likely to be too large for the poster. You can resize it using the handles. Click and drag column/row borders to reposition them.
   
   Note there is a minimum row height governed by the font size.
4. To change the font or paragraph formatting, select the table by clicking on the table border.
   
   Then select the **Home** tab and use the Font and Paragraph groups.
5. To affect just one or more cells, click and drag over them to select them first.
Modify a table

The tools used to modify a table’s design and layout are the same as those found in Microsoft Word.

Follow these steps:

1. To change the table design, click anywhere in the table and select the Design tab.
   Use the Table Styles group tools.
   You can use an existing design, or create your own by using the Shading button for selected cells.

2. To make changes to the layout, for example deleting rows or merging cells, select the Layout tab.
   Use the tools in the Layout groups.
   Note that you can affect the whole table by clicking on the table border.
   You can affect individual cells by first selecting one or more of them by clicking and dragging over them.
   You can select a row or column by clicking in one of its cells and using in the Table group.
Insert an existing table

It is possible to copy and paste a table from Word into PowerPoint. This is not always successful, particularly because the font sizes required are so different.

Follow these steps:

1. Open your Word document. Click into the table and click on the table selector button at the top left. Use Ctrl+C to copy to the clipboard.

2. Switch to PowerPoint and use use Ctrl+V. The table is pasted at its original size. Move and resize the table using the handles; this does not resize the text. You can modify the table using the Design and Layout tabs (see the relevant How To sections).

3. The default option for pasting a table is to recreate the table in PowerPoint using the local style. You can experiment with other options by clicking on the Paste Options button.

   - Keep text only
   - Insert as a vector image
   - Embed as a Word table
   - Keep source formatting
   - Use destination styles

Note that the Picture option creates a vector image which resizes well. The Embed option keeps the table as a Word object – double-clicking on it will enable editing of the table using features of Word.
Print a poster proof

Proof-reading your poster is an important part of the process. It isn’t practical to print the poster at actual size so you need to print a reduced-size version.

Follow these steps:

1. Select the **File** tab.
2. Select the Print option.
3. In the Settings section, click on **Full Page Slides**
4. Click on the **Scale to Fit Paper** option
5. Click **Print**
Create a PDF for printing

Most print departments will accept a PowerPoint file, however there can sometimes be issues arising from compatibility between versions and availability of fonts. It is much simpler to create a PDF version of the poster and use this for printing.

Follow these steps:

1. Make sure you have saved your poster.
2. Select the File tab.
3. Click on Save As
   In the Save As dialog, select PDF (*.pdf) in the Save as type drop down.
   Put a tick in the Open file after publishing option.
   Select the Standard publishing option
4. Select a suitable folder, give a suitable name for the poster and then click Save.

After a short delay, the poster will be displayed in the Adobe PDF Reader program for you to check.
Inserting a video clip

PowerPoint understands a number of different video formats including .wmv, .avi, .mp4, .mov but requires support from underlying software in order to play them back. Always test your video on the computer you will be using to deliver the poster.

Follow these steps:

1. Select the **Insert** tab.
2. Click on the video dropdown in the **Media** group and select **Video from file**.
3. In the **Insert Video** dialog, select the file and click **Insert**.
4. The video will be inserted onto the slide. For a large video there may be a short delay.
   The video is now part of the presentation; the presentation file will be considerably bigger!
5. You can drag, resize and rotate the video as you would an image.
6. You can test the video by clicking on the **Play** button.
7. Click on the video to select it.
   Click on **Playback** in the **Video Tools** tab.
8. In the **Video Options** group, click on the **Start** dropdown and choose either **On Click** or **Automatically**.
Inserting an audio clip

PowerPoint understands a number of different audio formats including .wav, .mp3, .aiff but requires support from underlying software in order to play them back. Always test your audio on the computer you will be using to deliver the poster.

Follow these steps:

1. Select the Insert tab.
2. Click on the video drop down in the Media group and select Audio from file.
3. In the Insert Audio dialog, select the file and click Insert.
4. The audio will be inserted onto the slide. The audio is now part of the presentation.
5. You can test the audio by clicking on the Play button.
6. You can drag, resize and rotate the audio placeholder as you would an image.
7. Resize the placeholder to be a suitable size to hold an image you would like to use as an alternative to the play button.
8. Click on Format in the Audio Tools tab. In the Adjust group, click on Change Picture.
9. In the Insert Picture dialog, select the picture. Click Insert.
Trimming a media clip

You may decide that you only want to play back a portion of a video or audio clip. PowerPoint enables you to trim the beginning and end sections.

Follow these steps:

1. Select your video or audio placeholder by clicking on it.
2. Click on Playback in the Video Tools or Audio Tools tab.
3. In the Editing group, click on Trim Video or Trim Audio.
4. In the Trim Video or Trim Audio dialogs, click and drag the beginning and end markers to trim off the unwanted portions of the media.
   You can use the media buttons to test the clip at any time.
5. Click OK.
   By default, the trimmed portions are kept by PowerPoint so that you can revisit the clip and adjust the amount of trimming.
Adding an action button

You can add an action (such as jumping to another page) to any object in PowerPoint. Here we will add an action to a shape, with the action jumping to another page.

Follow these steps:

1. Select the **Home** tab.
   Create a second page (slide) by clicking on the **New Slide** button in the **Slides** group.

2. Add content to the page. This could be anything: text, images, media. Go back to the poster page.

3. Select the **Insert** tab.

4. In the **Illustrations** group, click on Shapes, and choose a shape. Click and drag the shape on to the page. Keep the shape selected.

5. In the **Links** group, click on the **Action** button.

6. In the **Action Settings** dialog, choose the **Hyperlink to** option and select **Next Slide**. Click **OK**.

7. Go to the second page, and in the same way, add a button that will jump back to the first page.
10 What Next?

We hope you have found this book useful. If you attended a taught session you will get sent an email with a link to a web page to give us anonymous feedback. We always value your feedback and use it to improve our sessions.

You may like to consider the following options to follow on from this session.

10.1. Other PowerPoint sessions

If you are interested in giving presentations which are not just slide after slide of bulleted lists, you will get some ideas from:

PowerPoint: Getting the Message Across

Details can be found on the Courses website at www.it.ox.ac.uk/courses

10.2. Course Clinic

We encourage everyone to work at their own pace. This may mean that you don’t manage to finish all of the exercises for this session. If you would like to complete the exercises while someone is on hand to help you, come along to one of the Course Clinic sessions that run during term time. More details are available from www.it.ox.ac.uk/courses/

10.3. IT Services Help Centre

The Help Centre is a good place to get advice about any aspect of using computer software or hardware. You can contact the Help Centre on (2)73200 or by email on help@it.ox.ac.uk

10.4. Downloadable course materials (WebLearn)

These course materials, plus the files you need to complete the exercises, are available as a course pack in the ITLP Portfolio at http://portfolio.it.ox.ac.uk – search for Conference Posters.

10.5. Further reading

Presentation Zen: Simple Ideas on Presentation Design and Delivery by Garr Reynolds, ISBN 0321525655


Any of Edward Tufte’s books, such as
11 Appendix - Interactive posters

Posters are invariably printed for display on poster boards at a conference, and subsequently for use around the department. However, a number of groups are experimenting with ‘interactive’ posters.

By interactive, we here mean a poster which has audio and/or sound embedded within it and ‘buttons’ which cause other elements to be displayed – perhaps an extended explanation of a complex diagram. Clearly, most interactive elements cannot be printed; these posters are intended to be displayed on large touch-sensitive monitors, or interactive whiteboards. The best interactive posters are designed so that they can also be printed, with the interactive elements substituted with appropriate placeholders.

*Before you create an interactive poster, you must liaise with the conference organiser to determine what display facilities will be available to you; there is as yet no generally agreed format or technology base for this type of poster.*

*To display an interactive poster requires a suitable computer and a compatible display (large screen or interactive whiteboard). You will need to provide these yourself, or check that they are available at the conference venue.*

11.1. Interactive poster size and orientation

As you will be aware, monitors and other display devices generally use a widescreen, landscape orientation, i.e. the width is greater than the height.

There are two aspect ratios (width:height) in common use: 16:9 and 16:10. 16:9 is more common on monitors and large LCD screens, and 16:10 more common for interactive whiteboards and projectors. To side-step the issue of whether we use one or the other of these common formats, a good compromise is to design your poster at A0 landscape. This is particularly useful if you expect your interactive poster to also be printed, but does mean that the poster will not completely fill either a 16:9 or a 16:10 display.

The figure below shows the effect of displaying an A format landscape poster on the different aspect ratio displays, including the 4:3 ratio for older monitors and projectors:

![Figure 9 An A format poster on different aspect ratio displays](image)

You will see that in each case, narrow bands are created at the top or bottom of the display. These bands will be black and generally don’t detract from the poster.
It is far better to have these bands than it is to adjust the image to completely fill the screen – this would distort the text and graphics.

11.2. Inserting video and audio

Inserting multimedia in presentation software such as PowerPoint is no more difficult than inserting an image. Once the media is on the slide (i.e. poster), we can trim the media so that only relevant a portion of it plays and set it up so that it plays when clicked. On a touch sensitive display, this will be when someone touches the media placeholder.

For video media, the presentation software usually displays the first frame of the video as a placeholder. Part of the poster design process will be to make sure that the frame displayed is useful both as an indicator to the poster reader that there is video content available, and as a placeholder for the video when/if the poster is printed.

For audio media, it can be useful to associate the audio with a (clickable) element on the poster (perhaps an image), again useful for when the poster gets printed.

Most presentation tools rely on the availability of other software when playing back multimedia. The large number of media formats, coupled with a variety of different software elements that can be used to interpret the media, means that it is not always possible to guarantee that media which plays on the poster when displayed by your computer will play back on a different computer. You either need to take your own computer with which to display the interactive poster, or check ahead of time with the person responsible for providing a computer at the venue.

11.3. Adding interactive elements

11.3.1. Action buttons

Most presentation software, including PowerPoint, allows the addition of ‘Action’ buttons to a slide (i.e. poster). An action button can carry out one of a number of different tasks, including:

- Jump to a different page in the current presentation (i.e. a second page in the poster)
- Jump to another presentation
- Run a programme
- Play a sound

A typical use in an interactive poster would be to jump to a different page containing more information about an aspect of the research. This information might be text, graphics and/or multimedia. If multimedia, then it is possible to set it up so that the media starts playing as soon as the page is displayed.

If you do jump to a different page, you will need to ensure that you include a button on that page to jump back to the main poster!

11.3.2. Flash

Only the later versions of PowerPoint on the Windows platform support the inclusion of Flash media files in a presentation, and the playback will depend on having Flash installed on the presentation computer. Flash is not supported in the Mac versions of PowerPoint.

If you need to include Flash, there is a useful Microsoft support article at: http://support.microsoft.com/kb/291875 that steps you through the techniques.
Your safety is important

Where is the fire exit?
Beware of hazards:
Tripping over bags and coats
Please report any equipment faults to us
Let us know if you have any other concerns

Your comfort is important

The toilets are along the corridor outside the lecture rooms
The rest area is where you registered
The swivel seats are adjustable
You can adjust the monitors for height, tilt and brightness

How shall we use this workshop?

Your options are:
Critique some past posters
Critique your posters
Hear some ‘words of wisdom’ from us
Create your own posters
Revisit your existing posters
Today’s topics closely follow the Poster Process

Choose your tool
Choose a focus for the poster
Plan your poster layout
Collect and insert images
Produce and insert diagrams
Create, insert, edit, format, your text
Choose and consistently apply colours
Proofread and print

PowerPoint is not the best tool for the job but it is adequate

Excellent
Adequate
Poor

InDesign, Scribus
PowerPoint
Word

Some layout decisions will be made for you, others are yours...

Conference organiser: Title
Size Orientation Layout

You: F o n t s

Choose a focus for your poster

History
Summary
Results
Enlightenment
Opportunity
Fear
Soothing
Humour?

How XYZ got to be here
An overview of XYZ
“I’ve finished!” and here’s XYZ
You might not know XYZ exists, but here it is
You might think XYZ isn’t possible, but here’s why it is
You might think XYZ is OK, but here’s why it isn’t
You might think XYZ is not OK, but here’s why it is
You might think penguins would make poor researchers and you would be absolutely right!
Decide what your poster is for…

Outreach and engagement

Overview:
Past
Present
Future

Decide what your poster is for…

Research results

Event advertising

Decide what your poster is for…

Some initial planning will save time

There are some things a poster must have

<table>
<thead>
<tr>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact details</td>
</tr>
<tr>
<td>Start ► Middle ► End</td>
</tr>
<tr>
<td>A ‘path’ to follow</td>
</tr>
<tr>
<td>• Headings</td>
</tr>
<tr>
<td>• Numbering</td>
</tr>
<tr>
<td>• Layout</td>
</tr>
<tr>
<td>• A design element</td>
</tr>
</tbody>
</table>
And some things a poster could have:

- Author images...
  ...because you won’t always be in front of your poster

- QR Code...
  ...because you can encode all sorts of data in it

An important first step is to set the page size:

Always do this first!

Common sizes are:
- A1 = 8 x A4
- A0 = 16 x A4
- Custom!

Poor alignment makes a poster look amateurish:

Make use of the alignment tools available:
- Ruler
- Grid (snap to)
- Drawing Guides
- Smart Guides
  (InDesign & PowerPoint 2010)

Everything should line up with something!
Use a layout grid to help

Empty space is part of the content!

<table>
<thead>
<tr>
<th>Percentage</th>
<th>Text</th>
<th>Graphics</th>
<th>Empty</th>
</tr>
</thead>
<tbody>
<tr>
<td>20-25%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40-45%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30-40%</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
There are two types of image

<table>
<thead>
<tr>
<th>Vector Images</th>
<th>Bitmap Images</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Metafile</td>
<td>TIF</td>
</tr>
<tr>
<td>AutoCAD</td>
<td>GIF</td>
</tr>
<tr>
<td>Bitmap Images</td>
<td>PNG</td>
</tr>
<tr>
<td></td>
<td>JPEG</td>
</tr>
</tbody>
</table>

You need to take care when resizing images

| Vector graphics resize well | Bitmap graphics don’t! |

For large printed images you need large numbers of pixels

At least:
- 200 dots per inch (dpi)
- 80 dots per cm

There are many sources for images...

For posters use the vector (scalable .eps) versions of the Oxford crest

But the most important image resource is your librarian!

Search for:
- oxford branding toolkit

Quadrangle

Rectangle
Presentation applications have a limited range of image editing tools

Original  Washout  Grey-scale  Crop  Flip  Brightness  Contrast

Using diagrams

Use the drawing tools to create your own diagrams

Your visitors won’t have time to assimilate large tables of data – charts are better

<table>
<thead>
<tr>
<th>Year</th>
<th>Sun Spots</th>
<th>Year</th>
<th>Sun Spots</th>
<th>Year</th>
<th>Sun Spots</th>
<th>Year</th>
<th>Sun Spots</th>
</tr>
</thead>
<tbody>
<tr>
<td>1935</td>
<td>1</td>
<td>1945</td>
<td>20</td>
<td>1955</td>
<td>15</td>
<td>1965</td>
<td>10</td>
</tr>
<tr>
<td>1936</td>
<td>40</td>
<td>1946</td>
<td>25</td>
<td>1956</td>
<td>5</td>
<td>1966</td>
<td>20</td>
</tr>
<tr>
<td>1937</td>
<td>10</td>
<td>1947</td>
<td>60</td>
<td>1957</td>
<td>20</td>
<td>1967</td>
<td>40</td>
</tr>
<tr>
<td>1938</td>
<td>100</td>
<td>1948</td>
<td>100</td>
<td>1958</td>
<td>50</td>
<td>1968</td>
<td>60</td>
</tr>
<tr>
<td>1939</td>
<td>80</td>
<td>1949</td>
<td>100</td>
<td>1959</td>
<td>10</td>
<td>1969</td>
<td>80</td>
</tr>
<tr>
<td>1940</td>
<td>60</td>
<td>1950</td>
<td>80</td>
<td>1960</td>
<td>20</td>
<td>1970</td>
<td>100</td>
</tr>
<tr>
<td>1941</td>
<td>40</td>
<td>1951</td>
<td>65</td>
<td>1961</td>
<td>35</td>
<td>1971</td>
<td>100</td>
</tr>
<tr>
<td>1942</td>
<td>23</td>
<td>1952</td>
<td>20</td>
<td>1962</td>
<td>35</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1943</td>
<td>10</td>
<td>1953</td>
<td>10</td>
<td>1963</td>
<td>50</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1944</td>
<td>10</td>
<td></td>
<td></td>
<td>1964</td>
<td>10</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Charts can be created in PowerPoint or pasted from Excel (and elsewhere)

Using text

Right-click to change elements
The size of the fonts is critical for readability.

Rule of thumb (for an A1 or A0 poster):

**Main title:** 72+
**Subtitles:** 54+
**Text:** 30+
**Sub-text:** 20+

Use one font for the body and one font for headings (and they might be the same!)

**Your Heading**

**Your Heading**

There are at least seven deadly sins of type

- **Take care reversing!**
- **Leave this to the media.**
- **No stroking**
- **Powerpoint can’t underline**
- **DON’T SHOUT**
- **Arghh!!!**
- **Three’s a crowd**

Choose backgrounds carefully - especially gradients

- Text
- Text
- Text
- Text
If your tool supports layers they can help with your poster design.

In PowerPoint, you can use the slide master as a background layer.

Colour choice is subjective but some combinations work better than others.

Screen colours are not the same as printed colours unless you take care…

RGB: Red Green Blue
CMYK: Cyan Magenta Yellow Black

Proofread your poster before your audience does it for you!

It is important that you proofread the poster carefully.

Get someone else to evaluate your poster.

Use the spell chequer.
IT Services can print your posters

<table>
<thead>
<tr>
<th>Large format colour printing</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A1 594 x 841 mm</td>
<td>A0 841 x 1189 mm</td>
</tr>
<tr>
<td>23 3/8 x 33 1/8 in</td>
<td>33 1/8 x 46 3/4 in</td>
</tr>
</tbody>
</table>

**Charges**
- A1 Matt paper £10.80
- A0 Matt paper £21.60
- A1 Satin paper £21.00
- A0 Satin paper £42.00

Allow 24-48 hours  
PDFs preferred!

**Questions?**

**The Plan**

**What you need to do:**
- Design your poster
- Choose your colours and font
- Set up the page size
- Set up any guides you need
- Source/create your images and diagrams
- Create your text
- Layout the poster
- Proofreading and printing

**david.baker@it.ox.ac.uk**